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Version 2.1 Introduction 
 
This document summarizes enhancements and changes made to the Easy software Version 2.1.  This 
upgrade includes Q-Video enhancements, Easy Ambulatory 2 updates, and multiple PSG enhancements.  
Cadwell highly recommends that you read the Easy PSG/EEG Version 2.1 Installation Instructions 
before installing software. 

 

New Optimal CPAP / BiLevel Pressure Event for PSG Data 
 
After a patient has been titrated on CPAP or BiLevel pressure, you may want to mark one pressure as the 
most optimal for the patient.  With Version 2.1 software, you can now mark the optimal CPAP and or 
BiLevel pressure by clicking the Sleep Score pull-down menu, highlighting Add Change Event, then 
clicking Set Optimal Pressure.  Or simply click the new Optimal Pressure button as seen below:   
 

 
 
 
 
A new optimal pressure report has been added to the report list.  The report is named ‘Easy Sleep Optimal 
CPAP – BiLevel Therapy Report’ (see page 6). 
 
Easy Version 2.1 will allow the user to select any previously entered CPAP or BiLevel pressure as Optimal 
Pressure.  The Optimal Pressure event can be added during data collection or review. 
 

 

Set the optimal CPAP or BiLevel pressure
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Include Snoring Arousals in RDI Calculations 
The Easy software will provide calculations for AHI and RDI.  Please note the difference between AHI and 
RDI described below:  

 AHI (Apnea Hypopnea Index) is the number of apneas and hypopneas occurring per hour of total 
sleep time.  Most reports in the Easy system are based on AHI.   

 RDI (Respiratory Disturbance Index) is the number of apneas and hypopneas per hour of sleep.  
The user can also configure Easy to include the total number of snore events with arousals in 
the RDI calculation.   

o Including Snore Events in the RDI Calculation - To include snoring arousals in the 
RDI calculations, click the Sleep Score pull-down menu, highlight Options, then click 
Detection Settings.  Click the Snoring tab, 
and then put a check in the “Include Snore 
Arousals in RDI Calculation” box. 

o Not Including Snore Events in the RDI 
Calculation - To not include snoring 
arousals in the RDI calculations, click the 
Sleep Score pull-down menu, highlight 
Options, then click Detection Settings.  
Click the Snoring tab, and then remove the 
check in the “Include Snore Arousals in 
RDI Calculation” box.  

 
All reports that contain the RDI descriptor will be 
dynamically controlled based on the snore detection settings.  
If report displays AHI, the AHI will always be based on 
apneas and hypopneas only.   
 
Note the detection settings and reports displayed below.  If the ‘Include Snore Arousals in RDI’ box is left 
unchecked, RDI calculations will remain unchanged from previous software versions and will be equal to 
AHI calculations.  If you want RDI to include snoring events with corresponding arousals, be sure to place 
a check mark in the Include Snore Arousals in the RDI box. 
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The following reports contain RDI calculations that will be based on the ‘Include Snore Arousals in RDI 
Calculation’ settings in the Snore Detection Menu. 

 Easy PSG Report 3 (RDI) 
 Easy Sleep Respiratory Report (RDI) 

Updated PSG Report Features 
Cadwell has made multiple changes based on customer feedback.  Below is a list of new and updated 
reports.   
 
 Updated Easy PSG Report – Changed RDI to AHI 
 New Easy PSG Report 2 – Updated Sleep Staging layout, changed RDI to AHI 
 New Easy PSG Report 3 (RDI) – RDI statistics are based on detection settings 
 New Easy Sleep Arousal Report – Added awakenings information 
 New Easy Sleep Awakening Report – New awakening event information 
 Updated Easy Sleep Body Position Report – Updated position table.  Added snoring and saturation 

information. 
 Updated Easy Sleep Cardiac Report – Added more information about R-R events 
 New Easy Sleep Optimal CPAP – BiLevel Therapy Report  
 New Easy Sleep Oximetry Report (Comprehensive) – Added more detailed oximetry table to page 3 
 New Easy Sleep PSG Narrative Report – A report for physicians 
 New Easy Sleep Recording Hour by Hour Summary Report – Breaks down recorded data into hourly 

segments 
 Updated Easy Sleep Respiratory Report – Changed RDI to AHI 
 New Easy Sleep Respiratory Report (RDI) – RDI statistics are based on detection settings. 
 New Easy Sleep Staging Reports – Updated report layout 
 
Additionally, enhancements have been made to the graphs included in the Easy reports.  Graphs will print 
darker to optimize clarity. 
 
Many Easy users have taken advantage of our custom reports.  We have added the following new report 
tokens:1 

 Recording Time (minutes only) 
 Recording Time (hours only) 
 Total Sleep Time (minutes only) 
 Total Sleep Time (hours only) 
 Total Time in Bed (minutes only) 
 Total Time in Bed (hours only) 
 REM latency from sleep onset (minutes only) 
 REM latency from sleep onset (hours only) 
 REM latency from lights out (minutes only) 
 REM latency from lights out (hours only) 
 Sleep Period Time (minutes only) 
 Sleep Period Time (hours only) 
 Stage 1,2,3,4,REM, Awake, Movement, Delta Sleep (minutes only) 
 Stage 1,2,3,4,REM, Awake, Movement, Delta Sleep (hours only) 
 Sleep Maintenance Efficiency (100xTST/SPT) 
 Total number of Long R_R Events 
 Total number of Short R_R Events 
 Apnea/hypopnea index for each cm of pressure 

                                                           
1 For more information, see the Documents folder on the Easy V2.1 install CD.  Open the Report Generation document 
and scroll down to the Appendix.  New tokens are identified by “NEW” next to the token name. 
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 Respiratory disturbance index for each cm of pressure 
 Mean SpO2 at 0.5 to 10 l/m 
 Minimum SpO2 at 0.5 to 10 l/m 
 Total number of PLM events (between light-out and light-on in NREM, REM 

and Awake) divided by hours of TST 
 Apnea/Hypopnea Index for each body position 
 Respiratory Disturbance Index (number apnea+hypopnea+snore arousal events 

per hour during sleep) for each body position 
 Apnea/hypopnea index during NREM and REM (number of respiratory events 

per hour of NREM/REM sleep) 
 Apnea/hypopnea index during total sleep time (number of respiratory events per 

hour of sleep) 
 Respiratory disturbance index during NREM and REM (number of respiratory 

events per hour of NREM/REM sleep) 
 Apnea Hypopnea Snore with arousal index during total sleep time 
 Respiratory disturbance index during total sleep time 
 Number of awakenings 1 minute or less 
 Number of awakenings more than 1 minute in length 
 Total number of awakenings 
 Awakenings index per hour of TST 
 Number of REM periods 
 Length of stage 1, 2, 3, or 4 during SPT 
 Length of stage 3 + 4 during SPT 
 Length of Wake during SPT 
 Length of REM during SPT 
 Stage 1, 2, 3, 4 percent during SPT 
 Stage 3 + 4 percent during SPT 
 REM percent during SPT 
 Wake percent during SPT 
 

All PSG graph tokens have modified time of day and elapsed time scales.   
New graphs include: 

 Elapsed time markers have been added to the top of all graphs (See the SpO2 graph displayed below) 

 SpO2 graph with 10% grid marks displayed behind oximetry data.  
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 Cardiac graph with grid marks displayed every 30 bpm displayed behind cardiac data. 
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 A new combined supplemental oxygen titration and CPAP pressure summary graph have been 

added to the Therapy Report, Therapy Event Report, Therapy Comprehensive Report, and the  
Easy Graphs report. 
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 Respiratory event graph with O2 desaturation and Arousal events included. 
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 The Position table has been updated to include snoring and SpO2 data.  The Easy Sleep Body Position 
Report includes this updated table. 

 
Position Time (min.) REM (min.) NREM (min.) Apnea

C / O / M 
Hypopnea AHI Mean

SpO2 
Sleep 

Snore Index

Supine 358.72 7.00 246.50 4 / 4 / 0 63 16.8 96.1 0.7 
Left 21.87 0.00 9.00 0 / 0 / 0 6 40.0 94.6 0.0 
Prone 0.00 0.00 0.00 0 / 0 / 0 0 --- --- --- 
Right 40.91 0.00 33.50 0 / 0 / 0 1 1.8 97.8 0.0 
Upright 0.00 0.00 0.00 0 / 0 / 0 0 --- --- --- 
Non-supine 62.78 0.00 42.50 0 / 0 / 0 7 9.9 96.2 0.0 

 
 

 Awakening Summary  (Added to new Easy Sleep Awakening Report) 
 

Associated Event Epoch 
Snoring 90 
Snoring 119 
Arousal 166 
Snoring 277 
Arousal 505 
Snoring 575 
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 The Optimal CPAP / BiLevel table calculates values for: 1) baseline, 2) pressure ranges excluding the 
optimal pressure, as well as 3) optimal pressure.  This table has been added to the new Easy Sleep 
Optimal CPAP – BiLevel Therapy Report. 

 
Therapy (cm H2O) Baseline

Pressure 
 
0 

CPAP
Pressure 
Range* 
7 - 13 

BiLevel
Pressure 
Range* 

13/10 - 15/11 

Optimal 
Pressure 

 
11 

Total Time (min.) 25.40 149.88 263.71 24.51 
# Periods 1 3 3 1 
 Wake (%) 68.91 31.53 38.87 9.13 
Stage 1 (%) 29.53 13.68 12.13 10.20 
Stage 2 (%) 1.56 27.76 19.91 12.24 
Stage 3 (%) 0.00 7.01 10.43 2.04 
Stage 4 (%) 0.00 13.87 2.54 0.00 
REM (%) 0.00 6.15 16.12 66.40 
Movement (%) 0.00 0.00 0.00 0.00 
# Arousals 3 53 65 4 
Arousal Index 22.8 31.0 24.2 10.8 
# Snore 0 32 218 1 
Snore Index 0.0 18.7 81.2 2.7 
AHI 60.9 24.0 12.3 21.6 
# Obstructive 0 3 6 1 
# Central 4 12 11 2 
# Mixed 3 22 5 2 
# Hypopnea 1 4 11 3 
Total Respiratory Events 8 41 33 8 
Mean NREM SaO2 (%) 92.3 92.6 94.2 91.1 
Mean REM SaO2 (%) --- 93.2 94.7 91.9 
Min NREM SaO2 (%) 84.0 83.0 88.0 86.0 
Min REM SaO2 (%) --- 91.0 91.0 89.0 
Position Supine (min.) 0.00 0.00 0.00 0.00 
Position Non-supine (min.) 25.40 149.88 263.71 24.51 

 

 Partition Analysis provides hourly data for the sleep measures listed in the table below.  This table has 
been added to the new Easy Sleep Recording Hour by Hour Report. 

 
 Hour 1 Hour 2 Hour 3 Hour 4 Hour 5
Real Time 23:07 - 

00:07 
00:07 - 
01:07 

01:07 - 
02:07 

02:07 - 
03:07 

03:07 - 
04:07 

Awake (min) 34 36 26 9 3 
NREM (min) 25 19 33 50 56 
REM (min) 0 3 0 0 0 
Delta Sleep (min) 0 3 6 3 11 
AHI 44.0 35.0 16.0 1.0 2.0 
Max Duration 
Resp Event (sec) 

57 55 49 3 32 

Supine Time (min) 60 60 38 60 60 
Snoring Index 0.0 7.0 0.0 0.0 0.0 
Arousal Index 35.0 42.0 53.0 42.0 45.0 
PLM Index 119.0 26.0 11.0 12.0 9.0 
CPAP Range (cmH20) 0 0 0, 5, 7, 9 9 9 
Supplemental Oxygen Range (Lpm) 0.0 0.0 0.0 0.0 0.0 
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 Oximetry Range provides TST and TIB values for each O2 level.  This table has been added to the 
Easy Sleep Oximetry Report (Comprehensive). 

 
SpO2 % % 

TST 
% 

TIB 
TST 

(min) 
SpO2 % % 

TST 
% 

TIB 
TST 

(min) 
100 % 0.0 0.0 0.0      
99 % 1.1 1.2 3.4 74 % 0.0 0.0 0.0 
98 % 39.9 34.7 119.4 73 % 0.0 0.0 0.0 
97 % 30.4 25.3 91.1 72 % 0.0 0.0 0.0 
96 % 7.8 8.4 23.4 71 % 0.0 0.0 0.0 
95 % 5.0 5.9 14.9 70 % 0.0 0.0 0.0 
94 % 2.9 3.6 8.6 69 % 0.0 0.0 0.0 
93 % 1.8 2.6 5.4 68 % 0.0 0.0 0.0 
92 % 1.5 2.1 4.4 67 % 0.0 0.0 0.0 
91 % 1.4 2.0 4.1 66 % 0.0 0.0 0.0 
90 % 1.2 1.9 3.5 65 % 0.0 0.0 0.0 
89 % 1.3 2.2 4.0 64 % 0.0 0.0 0.0 
88 % 1.0 2.0 3.0 63 % 0.0 0.0 0.0 
87 % 0.9 1.8 2.6 62 % 0.0 0.0 0.0 
86 % 0.6 1.4 1.8 61 % 0.0 0.0 0.0 
85 % 0.6 1.2 1.8 60 % 0.0 0.0 0.0 
84 % 0.5 0.8 1.5 59 % 0.0 0.0 0.0 
83 % 0.3 0.7 0.9 58 % 0.0 0.0 0.0 
82 % 0.2 0.4 0.6 57 % 0.0 0.0 0.0 
81 % 0.1 0.2 0.3 56 % 0.0 0.0 0.0 
80 % 0.1 0.2 0.3 55 % 0.0 0.0 0.0 
79 % 0.1 0.1 0.2 54 % 0.0 0.0 0.0 
78 % 0.0 0.0 0.1 53 % 0.0 0.0 0.0 
77 % 0.0 0.0 0.0 52 % 0.0 0.0 0.0 
76 % 0.0 0.0 0.1 51 % 0.0 0.0 0.0 
75 % 0.0 0.0 0.0 50 % 0.0 0.0 0.0 

         
Total 90% - 99% 92.9 87.7 278.3 Total 70% - 74% 0.0 0.0 0.0 
Total 95% - 99% 84.2 75.5 252.3 Total 60% - 69% 0.0 0.0 0.0 
Total 90% - 94% 8.7 12.2 26.0 Total 65% - 69% 0.0 0.0 0.0 
Total 80% - 89% 5.6 10.9 16.8 Total 60% - 64% 0.0 0.0 0.0 
Total 85% - 89% 4.4 8.6 13.1 Total 50% - 59% 0.0 0.0 0.0 
Total 80% - 84% 1.2 2.3 3.7 Total 55% - 59% 0.0 0.0 0.0 
Total 70% - 79% 0.1 0.1 0.4 Total 50% - 54% 0.0 0.0 0.0 
Total 75% - 79% 0.1 0.1 0.4     

 
 
 
 
 
 
 
 
 
 
 
 



 Title Easy PSG/EEG Feature Changes 

                                                         ® P/N 369023-810 v2.1 
 Author BA Rev 1.1 
 Date 16-Mar-06 
 Page 9 of 15 
 

 

 

Auto-Impedance Check at Start of Study 
 
Easy Users can now configure the Easy system to automatically display impedance data at the start of a 
recording.  To enable the new Auto-Impedance feature, click the View pull-down menu, click on the 
Options menu, then click on the Recording tab.  Click the on the Auto-Impedance box to enable this option.  
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New Post Recording File Transfer Features  
 
Easy Users can now copy files to a server location.  Previous versions of the Easy software only allowed 
move options.  Users can now keep the original file on the data collection computer and copy the file to a 
networked location. 
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New Features Added in Previous Releases of the Easy Software 
 

Easy Stamp – Shortcut for Entering and Modifying PSG (available during 
data collection) 
The Easy Stamp provides a way to rapidly enter sleep events using predefined event durations.  After 
setting up the default event length, a simple right click of the mouse places the event mark over the event.  
A second right click extends the event a predetermined length.  One or two clicks and your on to the next 
event.  It's just that easy. 

From the Sleep Score pull-down menu, select Options then Easy Stamp -or click . 

 
 
 For each of the seven sleep events, turn Easy Stamp availability on or off by selecting Yes or No in 

the first column. 
 In the Duration column, select the length you want the event to be after clicking the right-mouse 

button on the designated trace. 
 In the Tap Extender column, select the length of any additional right-mouse clicks (multiple right 

mouse clicks adds this length to the event).   
 Toggle event text on or off in the Event Text column to disable the display of event related text at the 

bottom of the screen during waveform review/scoring. 
 Automatically associate an arousal with an event by selecting 'Yes' in the final column. 
 Click OK when done. 

 
Marking Sleep Events Using Easy Stamp 
 
 Move the mouse vertically over the trace until the cursor changes and displays the sleep event you 

wish to mark, then right click the mouse.  The stamped event mark is based on the length designated 
in the Options window (see above). 

 To lengthen the event right click again.  The event duration will increase based on the setting in the 
Tap Extender column for the event. 

 To shorten the event, left click and drag the event to the desired length. 
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Real Time Scoring Feature (available during data collection) 
 
All standard scoring features and procedures, including both manual and auto-scoring, are available while 
recording the PSG.  For detailed scoring instructions see the chapters listed under the Sleep Scoring book 
of this help file. 
 
 Select Score Real Time from the Sleep Score pull-down menu.   

 The Summary Graphs window opens.  To start scoring from the beginning of the recording, click the X 
in the upper right had corner.  To open the scoring window at a time that corresponds to an area on the 
graphs, point the mouse at the location in the graph then left click the mouse. 

 Both the scoring window and the recording window are displayed side by side in Windows Tile 
format.   

 Add events to either window by making that window the “active” window.  To activate a window, 
click anywhere within the window.  The header at the top of the window (i.e., the patient name) is 
displayed in bold indicating that the window is active.  Alternatively, click the Window pull-down 
menu and select either listing of the record. 

 With the scoring window active you can enter events or stage epochs using standard manual scoring 
procedures or the auto-detect events feature.   

 Resize the two windows if desired by clicking and moving their adjacent borders.  Maximize either 
window by clicking the Maximize button in the upper right hand corner of that window.  To switch 
between the two maximized windows, click the Window pull-down menu and select either listing of 
the record.  To tile both windows again, select Tile from the Window pull-down menu.   

 New data is automatically appended to the scoring window every minute.  If you reach the end of the 
data you can let it update automatically or you can manually update the window by paging forward 
(click the Forward Page button or click on the right side of the window).  To update the all night 
summary graphs, click the Graph Refresh button. 

 To generate a report, you must pause the recording.  Click within the data collection window to make it 
active.  The header at the top of the data collection window (i.e., the patient name) is displayed in bold.  
Click the Stop/Run button to pause the recording.  Click within the Score Real Time window.  Select 
Report Menu from the File pull-down menu, and then select the desired report.  Print the report, close 
the report window, and then click within the data collection window to activate it.  Click the Stop/Run 
button to restart the recording. 

 To close the scoring window, click the X in the upper right hand corner of the scoring window.   

 Click the Maximize button of the recording window to enlarge this window to normal size. 

 Open and close the scoring window as needed during the PSG recording.   



 Title Easy PSG/EEG Feature Changes 

                                                         ® P/N 369023-810 v2.1 
 Author BA Rev 1.1 
 Date 16-Mar-06 
 Page 13 of 15 
 

 

 

DVD Archiving Capability  
The Easy software now supports writing to DVD-R, DVD+R, CD-RW and CD-R discs.  The types of discs 
that can be used will depend on the DVD/CD drive that is in or connected to your Easy computer.  Some 
drives will support all of the above disk types, while other drives may only support a few of them.  If the 
drive supports multiple disks, the Easy software will also recognize the different disc types.  If the Easy 
system has multiple drives in the computer, each drive will need to be configured separately. 

Configuring a DVD/CD drive: 

1 Select Settings from the Tools pull-down menu. 
2 Click Add Device to open the Archive Device 

dialog box. 
 

3 Check the "Is DVD or CD Drive" check box.  
The drive letter followed by the name 
automatically displays in the DVD/CD field.  
Type “CD” or “DVD” in the Name field.  
This name is used to identify the drive in the 
Archive window.  If more than one archive 
device exists, also include the drive letter in 
the Name field as shown to the right. 

 
 

The pull-down menu for the Write Speed box contains all the available write speeds for the selected 
drive.  The highest speed is selected by default. 

CD drives:  Check the box "Always Cache Files for CD Write". 
If the Always Cache Data box is checked, the data will be copied to an intermediate file before 
being written to the CD.  This minimizes file seeks during the actual writing process and reduces the 
risk of a buffer under-run.  If the data is from a network source it will automatically be cached 
locally and then written to the CD. 

DVD drives:  Do not check the box "Always Cache Files for DVD Write". 

4 Click OK. The device should be included in the Archive Devices list. 
 
Archiving to DVD/CD: 
The archiving process is unchanged except for the added reference to DVD on the "Archive to" button.  For 
complete archiving instructions select Help Topics from the Help pull-down menu.  Double click on the 
Archiving book and select the Archiving a Record topic. 

 

 

 

 



 Title Easy PSG/EEG Feature Changes 

                                                         ® P/N 369023-810 v2.1 
 Author BA Rev 1.1 
 Date 16-Mar-06 
 Page 14 of 15 
 

 

Q-Video  
Modifications have been made to the Q-Video software to achieve higher frame rates on Easy II systems 
running the Windows XP operating system.  These changes will allow the Easy system to achieve higher 
frame rates when the user selects an increased frame rate setting while collecting Q-Video data. 

Easy Ambulatory 2 EEG Recorder with QMotion 

The Cadwell Easy Ambulatory 2 is our new multi-channel EEG recording system.  The Easy 
Ambulatory 2 integrates high performance amplifier hardware in a small, lightweight, rugged, EEG system. 
 
This extremely modular and flexible system is comprised of three modules: the 5 oz. recorder, the 32-
channel amplifier and the alkaline battery holder.  Optional modules for body position and limb movement 
are also available and provide the QMotion display of the patient during review. 
 
For detailed instructions on using this option, please refer to Easy Ambulatory 2 Manual document found 
on the upgrade CD in the Documents folder or the Easy Ambulatory 2 Topics found under Help in the Easy 
EEG/PSG software. 
 
To receive information by mail or an onsite demonstration, please contact Cadwell Laboratories at (800) 
245-3001 and ask for Customer Service. 

New Toolbar for Persyst Users 
If your system has the Persyst option, the following toolbar is available when you have a record open for 
either recording or review. 
 

 
 1st 2nd 3rd 4th 5th 6th 

1st button opens the Reveal program. 

2nd button opens the Spike Review program. 

3rd button opens the Prism Spectrum program. 

4th button opens the Prism Voltage Plot program. 

5th button allows the user to enter a Spectrum event (see below). 

6th button allows the user to enter a VPlot event (see below). 

The 5th and 6th buttons become available when you open the associated Persyst programs. 
 
The process for entering an event is similar to entering a comment event in the Easy software.  Click the 
event button; place the event in the data view with the event marker; then enter event specific information 
in the event window.  Examples of each event window are displayed below. 
 

 
 

The duration is measured in seconds. 
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Please see Persyst documentation for further details. 
 


